Monte Carlo Simulation
Using SimVoi

10.1 SIMVOI OVERVIEW

SimVoi is a Monte Carlo simulation add-in for Microsoft Excel 2007 & 2010 & 2013 & 2016
(Windows) and Microsoft Excel 2011 & 2016 (Macintosh).

SimVoi facilitates Monte Carlo simulation by providing:
Seventeen random number generator functions
Ability to set the seed for random number generation
Automatic repeated sampling for simulation
Frequency distributions of simulation results
Histogram, cumulative, and bivariate charts
Value of information for input assumptions of your model

Your spreadsheet model may include uncontrollable uncertainties as input assumptions. Examples
are demand for a new product, uncertain variable cost of production, or competitor reaction. You
can use simulation to determine the uncertainty associated with the model's output (annual profit).
You assess the probabilities for the input assumptions, and SimVoi automates the simulation by
trying hundreds or thousands of what-ifs consistent with your assessments.

SimVoi provides (1) random number generator functions as inputs for your model, (2) automates
Monte Carlo simulation, (3) summarizes results in tables and charts, and (4) computes value of
information.

To use SimVoi:

(1) Refer to the “How To Install Addin” PDF file for installation instructions.

(2) Create a spreadsheet model.

(3) Optionally use Senslt to identify critical inputs.

(4) In each input cell of your model enter one of SimVoi's random number generator functions.

(5) In Windows Excel 2007 & 2010 & 2013 & 2016, choose Add-Ins > SimVoi Simulation
(Control+Shift+V). In Mac Excel 2011, choose Tools > SimVoi Simulation
(Option+Command+v). In Mac Excel 2016, press Option+Command-+v.

(6) Specify the model output cell, information cells, and the number of what-if trials.

(7) Interpret simulation results. SimVoi gives you tables, histograms, cumulative charts,
bivariate charts, and value of information.
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All of SimVoi’s functionality is in the single SimVoi XLAM file. There is no separate setup file or
help file. When you use SimVoi on a Windows computer, it does not create any Windows
Registry entries (although Excel may use such entries to keep track of its add-ins).

10.2 USING SIMVOI FUNCTIONS

SimVoi adds seventeen random number generator functions to Excel:
RandBeta(alpha,beta,,[MinValue],[MaxValue])
RandBinomial(trials,probability s)
RandBiVarNormal(meanl,stdev1,mean2,stdev2,correl12)
RandCumulative(value _cumulative_table)
RandDiscrete(value_discrete_table)
RandExponential(lambda)

RandlInteger(bottom,top)
RandLogNormal(Mean,StDev)
RandNormal(mean,standard_dev)

RandPoisson(mean)

RandSample(population)
RandTriangular(minimum,most_likely,maximum)
RandTriBeta(minimum,most_likely,maximum,[shape])

RandTruncBiVarNormal(mean1,stdevl,mean2,stdev2,correl12,
[minl],[max1],[min2],[max2])

RandTruncLogNormal(Mean,StDev,[MinValue],[MaxValue])
RandTruncNormal(Mean,StDev,[MinValue],[MaxValue])
RandUniform(minimum,maximum)

You can use these functions as inputs to your model by typing in a worksheet cell. Or, in
Windows Excel, from the Formulas ribbon, choose Insert Function and select the User Defined
category. In Mac Excel, choose Formula Builder from the Formulas ribbon or choose Function
from the Insert menu, search for Rand, and select from the User Defined list.

The SimVoi Rand functions include extensive error checking of arguments. After verifying that
the functions are working properly, you can substitute the SimVoi Fast functions. These have
minimal error checking and therefore run faster.

10.3 UPDATING LINKS TO SIMVOI FUNCTIONS

When you insert a SimVoi random number generator function in a worksheet cell, the function is
linked to the folder location of the current SimVoi XLAM file. During the current Excel session,
the formula bar shows only the name of the SimVoi function. When you save and close the
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workbook, Excel saves the complete path to the folder location of the SimVoi function. For
example, after closing and reopening the workbook, the formula bar might show
="C:\MyAddIns\SimVoi-Addin.xlam’!RandNormal(100,10). This is standard behavior for Excel
user defined functions like the ones contained in the SimVoi XLAM file.

When you open the workbook, Excel looks for the SimVoi XLAM file using the saved path. If
you deleted the SimVoi XLAM file or if you opened the workbook on another computer where the
SimVoi XLAM file is not located at the same path, Excel cannot find the SimVoi XLAM file at
the saved path location. Excel displays a dialog box like the one shown below.

Figure 10.1 Excel 2010 Warning To Update Links
f Microsoft Excel ﬁw

This workbook contains one or more links that cannot be updated.

l % «To change the source of inks, or attempt to update values again, dick Edit Links.
» To leave the links as is, dick Continue.

[ contrue |
Was this information helpful?

Mac Excel will show a similar warning with an Edit Links button. If the SimVoi XLAM file is
open or if SimVoi has been installed, click the Edit Links button.

Figure 10.2 Excel 2010 Edit Links Dialog Box

-
Edit Links
Source Type Update Status
SimVoi-Addin.xlam  Worksheet A Error: Source not found

l o m

Location: C:\MyAddins

Update: (@ Automatic Manual

Startup Prompt...

To update the links, click the Change Source button. A file browser window will open. Navigate
to the SimVoi XLAM file that is open. Select the file using the file browser, and click OK. Back
in the Edit Links dialog box, click the Close button.

If you do not immediately update links when the file is opened, you can update the links later as
long as the SimVoi XLAM file is open or installed. To do so, in Excel 2007, choose Office Button
> Prepare > Edit Links to Files to see the dialog box shown below. In Excel 2010 & 2013, choose
File > Info > Edit Links to Files to see the Edit Links dialog box. In Mac Excel, from the Edit
menu choose Links.
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10.4 RANDOM NUMBER SEED

The "Random Number Seed" edit box on the SimVoi dialog box allows you to set the seed for
SimVoi's random number generator functions. The seed must be an integer in the range 1 through
2,147,483,647. SimVoi's random number generator functions are completely independent of
Excel's built-in RAND function.

Random numbers generated by the computer are actually pseudo-random. The numbers appear to
be random, and they pass various statistical tests for randomness. But they are actually calculated
by an algorithm where each random number depends on the previous random number. Such an
algorithm generates a repeatable sequence. The seed specifies where the algorithm starts in the
sequence.

A Monte Carlo simulation model usually has uncontrollable inputs (uncertain quantities using
random number generator functions), controllable inputs (decision variables that have fixed values
for a particular set of simulation iterations), and an output variable (a performance measure or
operating characteristic of the system).

One use of the random number seed is to reduce variation. For example, a simple queuing system
model may have an uncertain arrival pattern, a controllable number of servers, and total cost
(waiting time plus server cost) as output. To evaluate a different number of servers, specify the
same seed before generating the uncertain arrivals. The variation in total cost will depend
primarily on the different number of servers, not on the particular sequence of random numbers
that generates the arrivals.

10.5 EXAMPLE MODEL

In this example the analyst is interested in the uncertainty about cash flow for a software
development project. It is difficult to express the uncertainty about cash flow directly, so the
analyst has constructed a simple what-if spreadsheet model where the cash flow depends on
assumptions about demand and costs. This analysis is based on a fixed price, but the other model
inputs are uncertain.

Figure 10.3 Display of Example Model

A ] B C D E F G H I
1 |Software Decision Analysis
2
3 |Controllable Input Variable
4 ‘Unit Price $79
5 |Uncertain Input Variables
6 Units Sold 898 Truncated Normal |Mean=1000, StDev=200, Min=500, Max=1500
7 Unit Variable Cost $8.36 Triangular Min=$6, Mode=$8, Max=511
8 Fixed Costs $12,000 Discrete Value| Probability
9 |Output Variable $10,000 0.3
10 Net Cash Flow $51,435 $12,000 0.5
11 $15,000 0.2

To show the use of several random number generator functions, we use the truncated normal,
triangular density, and a discrete distribution. In your own initial analysis of a problem, you might
choose to use the triangular density with estimates of the minimum, most likely, and maximum
values for each input assumption.
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Figure 10.4 Formulas of Example Model

A | B C
Controllable Input Variable
|Unit Price $79
Uncertain Input Variables
Units Sold =randtruncnormal(1000,200,500,1500)

Unit Variable Cost
Fixed Costs
Output Variable

lNet Cash Flow

=randtriangular(6,8,11)
=randdiscrete(F9:G11)

guooo\:mu-l|4>w

=C6*(C4-C7)-C8

After entering random number generator functions, recalculate the worksheet to verify that the
functions and the output function Net Cash Flow are generating appropriate values. To recalculate,
in Windows Excel press F9 repeatedly. In Mac Excel, hold down the Command key and press the
= key repeatedly.

10.6 MONTE CARLO SIMULATION

After you specify random number generator functions as inputs to the model, to perform Monte
Carlo simulation in Windows Excel 2007 & 2010 & 2013 & 2016, choose Add-Ins > SimVoi
Simulation or press Control+Shift+V. In Mac Excel 2011, choose Tools >> SimVoi Simulation or
press Option+tCommand-+v. In Mac Excel 2016, press Option+Command-+v. The SimVoi dialog
box appears.

Figure 10.5 SimVoi Dialog Box for Example Simulation
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The example model is in a worksheet named Model.

Select the Output Value Cell edit box, and point to a single cell on your worksheet. The output cell
must contain a formula that depends (usually indirectly) on the model inputs determined by the
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random number generator functions. In the example, the Output Value Cell is C10 on the Model
worksheet, so the edit box displays Model!$C$10.

Information Cells are any other cells that you want to monitor for simulation results. In the
example, the range C6:C8 is selected. All Information Cells must be on a single worksheet, which
may be different from the worksheet containing the Output Value Cell. To select multiple cells or
multiple ranges, select the first cell or contiguous range of cells, and then hold down the Ctrl key
(Windows) or Command key (Macintosh) while you select the other cells or ranges of cells.

Click the Monte Carlo Simulation Only option button, select the Number of Trials edit box, and
type an integer value for the number of what-if trials. This value, sometimes called the sample size
or number of iterations, specifies the number of times the worksheet will be recalculated to
determine output values of your model. One row is needed for each trial, and several additional
rows are used for labels, so the number of trials is limited to approximately 65 thousand in XLS
workbooks and slightly more than one million in XLSX workbooks. In the example, the Number
of Trials is 500.

If you specify one or more Information Cells, you can check the Bivariate Charts box to obtain
correlations and charts. The correlations are based on the total Number of Trials, but you may
specify a smaller Number of Points for Each Bivariate Chart if you think the scatter pattern may
be obscured by a large number of points. In the example, the Number of Points for Each Bivariate
Chart is 100.

If you want a cumulative relative frequency chart in addition to a histogram for each variable,
check the Cumulative Charts box, and specify the Number of Points for Each Cumulative Chart.
In the example, the number of points is 100.

Leave the Random Number Seed unchanged, or select the Random Number Seed edit box, and
type a number between 1 and 2,147,483,647. Use an integer value without commas or other
separators. In the example, the seed is 12345678.

For terse help, click the Help button. SimVoi will create a help worksheet in your current
workbook.

To start the simulation, click the Simulate button. Be sure to wait until all calculations and charts
are complete.

10.7 SIMULATION DATA

SimVoi creates a new worksheet in your Excel workbook named SimVoi.l Simulation Data.
Column A shows an integer for each trial 1 through the Number of Trials you specified. Column B
shows the result in the Output Value Cell, and subsequent columns show results for each
Information Cell.

SimVoi looks for text labels one or two cells to the left and one or two cells above the Output
Value Cell and each Information Cell. If text is found, the text is shown in row 1; otherwise, the
cell address is shown.



Figure 10.6 First Ten Trials of Simulation Data

A B C D E
1 | Trial| Net Cash Flow| Units Sold| Unit Variable Cost| Fixed Costs
2 1 $48,155 854 $8.58 $12,000
3 2 $70,683 1170 $8.32 $12,000
4 3 $86,437 1371 $7.20 $12,000
5 4 $66,834 1079 $7.81 $10,000
6 5 $77,635 1283 $9.13 $12,000
7 6 $61,920 1060 $6.41 $15,000
8 7 $70,156 1125 $7.72 $10,000
9 8 $90,185 1422 $8.56 $10,000
10 9 $47,412 805 $7.72 $10,000
11 10 $47,154 835 $8.13 $12,000

In columns to the right of the simulation results, SimVoi also displays the date, time, workbook

name, and other information about the simulation.

Figure 10.7 SimVoi Summary Information on Simulation Data Sheet

G H |
1 |SimVoi Simulation Data
2
3 |Date (current date)
4 |Time (current time)
5
6 [Workbook (file name)
7
8 [Number of Trials 500
9 |Seed 12345678
10
11 |Output Value Worksheet Model
12 |Output Value Cell SCS10
13 |Output Value Label Net Cash Flow
14
15 |Information Worksheet Model
16 |Information Cell SCS6
17 |Information Label Units Sold
18
19 |Information Worksheet Model
20 [Information Cell SCS7
21 |Information Label Unit Variable Cost
22
23 |Information Worksheet Model
24 [Information Cell SCS8
25 |Information Label Fixed Costs

10.7 Simulation Data

115
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10.8 UNIVARIATE SUMMARY

SimVoi displays the Univariate Summary sheet for each simulation, regardless of which options

are selected in the SimVoi dialog box. The top left of the sheet shows summary measures for the
output variable and each of the information variables. The summary measures are based on Excel
worksheet functions AVERAGE, STDEV, QUARTILE, and SKEW.

Figure 10.8 SimVoi Numerical Output for One-Output Example

A | B C D E

1 |SimVoi Univariate Summary

2

3 Net Cash Flow| Units Sold| Unit Variable Cost| Fixed Costs
4 [Mean $58,661 998 $8.24 $11,948
5 [St. Dev. $13,662 191 $1.01 $1,746
6 [Mean St. Error $611 9 $0.05 $78
7 |Skewness +0.146 +0.160 +0.300 +0.606
8

9 [Minimum $21,700 520 $6.15 $10,000
10 [First Quartile $49,194 862 $7.49 $10,000
11 [Median $58,210 995 $8.14 $12,000
12 |Third Quartile $67,787 1125 $8.89 $12,000
13 |Maximum $95,938 1485 $10.79 $15,000

Below the summary measures are selected percentiles, based on Excel’s PERCENTILE worksheet
function. The QUARTILE and PERCENTILE functions both use interpolation when necessary, so
some values may be fractional, e.g., the first quartile or twenty fifth percentile in this example.
Refer to Excel's online help for the interpolation method used by the PERCENTILE function.

Figure 10.9 Portion of Excel PERCENTILE Values

A B C D E

16 |Excel PERCENTILE

17 Net Cash Flow| Units Sold| Unit Variable Cost| Fixed Costs
18 0.0% $21,700 520 $6.15 $10,000
19 0.5% $28,253 560 $6.28 $10,000
20 1.0% $28,448 585 $6.35 $10,000
21 2.5% $33,934 657 $6.50 $10,000
22 5.0% $36,675 701 $6.70 $10,000
23 10.0% $40,857 747 $6.98 $10,000
24 15.0% $43,876 805 $7.15 $10,000
25 20.0% $47,316 832 $7.36 $10,000
26 25.0% $49,194 862 $7.49 $10,000

For each variable SimVoi provides a five-column summary with histogram. The top section has
simulation information and summary measures.
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Figure 10.10 Portion of Univariate Summary for Each Variable

H | | J K L

1 |SimVoi Univariate Summary Mean $58,661
2 |Date (current date) St. Dev. $13,662
3 [Time (current time) Mean St. Error S611
4 |Trials 500 Skewness +0.146
5 |Seed 12345678

6 [Workbook |(file name) Minimum $21,700
7 First Quartile $49,194
8 |Worksheet |Model Median $58,210
9 [Cell SCcs10 Third Quartile | $67,787
10 [Label Net Cash Flow Maximum $95,938
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In the five-column range, the histogram is a combination chart, using an Excel column chart type
for the vertical bars and an XY Scatter chart type for the horizontal axis.

Figure 10.11 Histogram

SimVoi Histogram For 500 Trials
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The histogram is based on the numerical values of the frequency distribution located below the
histogram and optional cumulative distribution chart. The distribution is computed using Excel’s
array-entered FREQUENCY worksheet function.
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Figure 10.12 Frequency Distribution

H [

49| Upper Limit Frequency
50 $20,000 0
51 $25,000 1
52 $30,000 6
53 $35,000 8
54 $40,000 30
55 $45,000 38
56 $50,000 52
57 $55,000 74
58 $60,000 67
59 $65,000 64
60 $70,000 63
61 $75,000 33
62 $80,000 32
63 $85,000 14
64 $90,000 9
65 $95,000

66 $100,000 1

If the Cumulative Charts box is checked on the SimVoi dialog box, the chart of cumulative
relative frequency is shown below the histogram.

Figure 10.13 Cumulative Chart

SimVoi Cumulative Chart For 100 Trials
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The cumulative chart is based on the sorted values and the cumulative relative frequencies, located
in columns to the right of the charts for the variables.



Figure 10.14 First Ten Values for Cumulative Charts

10.9 Bivariate Summary

Al AK AL AM AN
1 Net Cash Flow| Units Sold| Unit Variable Cost| Fixed Costs| Cumul.Rel.Freq.
2 $26,634 539 $6.41 $10,000 0.005
3 $30,400 601 $6.60 $10,000 0.015
4 $30,782 614 $6.63 $10,000 0.025
5 $33,722 676 $6.63 $10,000 0.035
6 $36,397 696 $6.78 $10,000 0.045
7 $37,711 701 $6.87 $10,000 0.055
8 $38,326 717 $6.96 $10,000 0.065
9 $38,446 732 $6.98 $10,000 0.075
10 $39,518 743 $7.04 $10,000 0.085
11 $39,668 744 $7.05 $10,000 0.095
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The cumulative relative frequencies start at 1/(2*N), where N is the number of trials, and increase
by 1/N. The rationale is that the lowest ranked value of the sample values from the simulation is

an estimate of the population values in the range from 0 to 1/N. The lowest ranked value is
associated with the median of that range.

10.9 BIVARIATE SUMMARY

If there are Information Cells and the Bivariate Charts box is checked in the SimVoi dialog box,
SimVoi creates a Bivariate Summary sheet. The top left area displays correlation coefficients, r,
and coefficients of determination, r-squared, for each pair of variables, based on Excel’s CORREL
and RSQ worksheet functions.

Figure 10.15 Bivariate Numerical Results

A | B C D E
1 [SimVoi Bivariate Summary
2
3
4 |Correlation Coefficient, r
5 |Excel CORREL, 500 Trials
6 Net Cash Flow | Units Sold | Unit Variable Cost | Fixed Costs
7 |Net Cash Flow 1.0000 0.9890 -0.0388 -0.1417
8 |Units Sold 0.9890 1.0000 0.0342 -0.0145
9 |Unit Variable Cost -0.0388 0.0342 1.0000 -0.0144
10 [Fixed Costs -0.1417 -0.0145 -0.0144 1.0000
11
12 |Coefficient of Determination, r-squared
13 |Excel RSQ, 500 Trials
14 Net Cash Flow | Units Sold | Unit Variable Cost | Fixed Costs
15 [Net Cash Flow 1.0000 0.9781 0.0015 0.0201
16 |Units Sold 0.9781 1.0000 0.0012 0.0002
17 |Unit Variable Cost 0.0015 0.0012 1.0000 0.0002
18 [Fixed Costs 0.0201 0.0002 0.0002 1.0000
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SimVoi creates an XY Scatter chart for each pair of variables. The chart is in the area to the right
of the numerical tables for r and r-squared, The top row of bivariate charts have the output variable
on the vertical axis.

Figure 10.16 Bivariate Chart With Strong Relationship

SimVoi Bivariate Chart For 100 Trials
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For the example, there is a very strong linear relationship between net cash flow and units sold.
There is almost no relationship between net cash flow and unit variable cost.

Figure 10.17 Bivariate Chart With Essentially No Relationship

SimVoi Bivariate Chart For 100 Trials
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Each bivariate chart is based on data arranged in columns located to the right of the charts.

Figure 10.18 First Ten Trials for Bivariate Charts

AP AQ AR AS
1 Net Cash Flow| Units Sold| Unit Variable Cost| Fixed Costs
2 $48,155 854 $8.58 $12,000
3 $70,683 1170 $8.32 $12,000
4 $86,437 1371 $7.20 $12,000
5 $66,834 1079 $7.81 $10,000
6 $77,635 1283 $9.13 $12,000
7 $61,920 1060 $6.41 $15,000
8 $70,156 1125 $7.72 $10,000
9 $90,185 1422 $8.56 $10,000
10 $47,412 805 $7.72 $10,000
11 $47,154 835 $8.13 $12,000

The top ten trials of data for the bivariate charts is the same as the top ten trials on the Simulation
Data sheet. The entire Simulation Data sheet may be deleted without affecting the display of the
bivariate charts.

10.10 VALUE OF INFORMATION

Extending the Monte Carlo simulation example, the decision maker must decide between the
software project and a fixed price job that would pay $50,000 using the same commitment of time
and related resources. Before choosing, the decision maker could gather some information to help
resolve the uncertainty associated with the software project. Which information about the three
uncertainties is most valuable, and how much should the decision maker be willing to pay for the
information?

The analyst uses SimVoi’s option for Value of Information to help answer the decision maker’s
questions.

SimVoi is appropriate for this kind of analysis if the Output Value Cell is a monetary value and
the Information Cells are uncertain inputs to the model.

The Number of Brackets box specifies the number of equally-probable ranges of values used to
approximate the probability distributions for the value of information calculations.

The Trials per Bracket box specifies the number of trial used for approximating each of the
brackets.

With 25 brackets and 20 trials per bracket, the simulation uses 25*20 = 500 trials. Using the same
random number seed, 12345678, the simulation results will be the same as before. The histograms,
cumulative charts, and bivariate charts will also be the same.
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Figure 10.19 SimVoi Dialog Box for Simulation and Value of Information
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SimVoi creates a chart showing the value of information for each Information Cell.

Figure 10.20 Chart for Value of Information for Each Information Variable

A B C D E F G
1 [SimVoi Value Of Information
2
3
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21

The chart shows how the value of information for the situation described by the model depends on
the value of an alternative situation.
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Referring to the Univariate Summary worksheet, the minimum value of simulation results for the
software project is $21,700. If an alternative project has an outcome value less than $21,700, then
clearly the software project is preferred, and there is no value for additional information about the
three uncertain inputs of the software model.

Similarly, the maximum value of simulation results for the software project is $95,938. If an
alternative project has an outcome value greater than $95,938, then clearly the alternative project
is preferred, and there is no value for additional information about the three uncertain inputs of the
software model.

If the alternative project has an outcome value between the two extremes of the software project,
there may be some value of obtaining information about the uncertain assumptions used in the
software model.

For the software example problem with an alternative project yielding $50,000, there is a positive
value associated with information about Units Sold. There is zero value for information about Unit
Variable Cost and Fixed Costs.

When the value of the alternative is $50,000, the exact value of information can be determined by
using the What-If calculations in the Units Sold section of the Value Of Information worksheet.

Figure 10.21 Example of What-If for Units Sold

J K L [ ™ N 0
24 |What-If Input $50,000| Value Of Alternative
25 \
26 $58,661| Average Value Of Simulation
27 $60,729| Average Value With Information, Units Sold
28 $58,661| Average Value Without Information
29
30 [What-If Output $2,067| Value Of Information, Units Sold
31
32
33 Conditional Conditional Data For Chart
34 Average Value Average Value Value Of Value Of
35 Bracket Of Simulation| With Information Alternative| Information
36 1 $89,201 $89,201 $21,700 S0
37 2 $79,779 $79,779 $21,849 S0
38 3 $76,814 $76,814 $21,997 S0
39 4 $73,781 $73,781 $22,146 S0
40 5 $70,249 $70,249 $22,294 S0

If you enter $50,000 into the What-If Input cell for Value Of Alternative and recalculate the
worksheet, the What-In Output cell shows $2,067. This is the most you should pay for perfect
information about Units Sold.

Another important use of value of information is sensitivity analysis. Instead of looking at the
effects of varying input values or probability, value of information combines both into its measure.
By examining the chart, it is easy to see that information about Units Sold is much more valuable
than information about Unit Variable Cost or Fixed Costs.

SimVoi determines value of information by first sorting the simulation results for an Information
Cell and associated Output Value Cell. SimVoi uses the Information Cell data as the sort key and
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sorts from highest value down to lowest value. The Trial number is included to make it easy to
verify the calculations.

Figure 10.22 Top Ten Rows of Sorted Data for Conditional EMV

AN AO AP

3 Sort Key

4 | Trial| Units Sold| Net Cash Flow
5| 322 1485 $90,700
6 43 1471 $90,922
7 | 188 1469 $92,973
8 | 239 1469 $93,967
9 | 206 1465 $91,794
10| 236 1462 $95,938
11] 114 1460 $93,300
12| 320 1445 $92,665
13] 136 1430 $88,405
14 8 1422 $90,185

Without any additional information, the average value of the simulation model is $58,661, i.e., the
mean of Net Cash Flow shown on the Univariate Summary worksheet.

In this example, the Number of Brackets is 25 and the Trials per Bracket is 20. In the sorted data
the first 20-row bracket is rows 5:24. When Units Sold is in the range 1349 to 1485, the associated
Net Cash Flow values range from $83,313 to $95,938 with average value $89,201. SimVoi uses
the name Conditional Average Value of Simulation for this average, and the value is displayed
below the What-If area on the worksheet. If we know that Units Sold is in this high range, average
value of the simulation is $89,201. The second bracket is rows 25:44 with conditional average
value $79,779. And so on, down to the twenty-fifth bracket in rows 485:504 with conditional
average value $31,784.

If we know that Units Sold is in a particular bracket, we compare the conditional average value of
the simulation with the value of the alternative, and we choose the highest. The third column
below the What-If area contains MAX functions, and the result is Conditional Average Value
With Information.

The average of the Conditional Average Value With Information values is the Average Value
With Information, Units Sold, shown in the What-If area. Also shown is the Average Value
Without Information, i.e., the maximum of the Average Value Of Simulation and the Value Of
Alternative. The Value of Information is the difference between the Average Value With
Information and the Average Value Without Information.

When the value of the alternative is $50,000, the value of information is $2,067. The value of
information is highest if the value of the alternative is the same as the average value of the
simulation model, i.e., $64,139 — $58,661 = $5,478.

The data for the chart is computed using approximately 500 equally-spaced values between the
minimum and maximum of the Net Cash Flow values from the simulation, including the value of
Average Value Of Simulation.
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10.11 RANDOM NUMBER GENERATOR FUNCTIONS

RandBeta

Returns a random value from a beta distribution.

Syntax
RandBeta(alpha,beta,[minimum_value],[maximum_value])

The required arguments alpha and beta determine the shape of the probability density function and
correspond to arguments of the same name used by the Excel family of beta functions. The
optional arguments correspond to lower bound A and upper bound B in the Excel beta functions.

Remarks
If any argument is nonnumeric, RandBeta returns the #VALUE! error value.
If alpha <= 0 or beta <= 0, RandBeta returns the #NUM! error value.

If you omit values for minimum_value and maximum_value, RandBeta returns values with
minimum_value = 0 and maximum_value = 1.

Example

The charts show the distribution for RandBeta with shape parameter values of 4 and 2,
minimum_value 2 and maximum_value 10.
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Figure 10.23 RandBeta Example Probability Density Function
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Figure 10.24 RandBeta Example Cumulative Probability Function
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RandBinomial

Returns a random value from a binomial distribution. The binomial distribution can model a
process with a fixed number of trials where the outcome of each trial is a success or failure, the
trials are independent, and the probability of success is constant. RandBinomial counts the total
number of successes for the specified number of trials. If n is the number of trials, the possible
values for RandBinomial are the non-negative integers 0,1,...,n.

Syntax
RandBinomial(trials,probability s)
Trials (often denoted n) is the number of independent trials.

Probability s (often denoted p) is the probability of success on each trial.

Remarks
Returns #N/A if there are too few or too many arguments.
Returns #NAME! if an argument is text and the name is undefined.

Returns #NUM! if trials is non-integer or less than one, or probability s is less than zero or more
than one.

Returns #VALUE! if an argument is a defined name of a cell and the cell is blank or contains text.

Example

A salesperson makes ten unsolicited calls per day, where the probability of making a sale on each
call is 70 percent. The uncertain total number of sales in one day is =RandBinomial(10,0.7)
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Figure 10.25 RandBinomial Example Probability Mass Function
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Figure 10.26 RandBinomial Example Cumulative Probability Function
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Related Functions
FastBinomial: Same as RandBinomial without any error checking of the arguments.

CritBinom(trials,probability s,RAND()): Excel's inverse of the cumulative binomial, or
CritBinom(trials,probability s,RandUniform(0,1)) to use the SimVoi Seed feature.
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RandBiVarNormal

Returns two random values from a bivariate normal distribution with specified means, standard
deviations, and correlation.

To use this random number generator function, select two adjacent cells on the worksheet. Type
=RandBiVarNormal followed by numerical values for the five arguments or references to cells
containing the values, separated by commas, enclosed in starting and ending parentheses. After
typing the ending parentheses, do not press Enter. Instead, hold down the Control and Shift keys
while you press Enter, thus "array entering" the function.

Syntax

RandBiVarNormal(meanl,stdevl,mean2,stdev2,correl12)

Remarks
Returns #REF! if the array function is not entered into two adjacent cells.

Returns #NUM ! if a standard deviation is negative or the correlation is outside the range between -
1 and +1.

Returns #VALUE! if an argument is not numeric.

Example

Select two adjacent cells, type
=RandBiVarNormal(100,10,50,5,0.5)

Hold down Control and Shift while you press Enter.

Related Function

FastBiVarNormal: Same as RandBiVarNormal without any error checking of the arguments. The
two adjacent cells must be in the same row.
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RandCumulative

Returns a random value from a piecewise-linear cumulative distribution. This function can model
a continuous-valued uncertain quantity, X, by specifying points on its cumulative distribution.
Each point is specified by a possible value, x, and a corresponding left-tail cumulative probability,
P(X<=x). Random values are based on linear interpolation between the specified points.

Syntax
RandCumulative(value cumulative table)

Value cumulative table must be a reference, or the defined name of a reference, for a two-column
range, with values in the left column and corresponding cumulative probabilities in the right
column.

Remarks
Returns #N/A if there are too few or too many arguments.
Returns #NAME! if the argument is text and the name is undefined.

Returns #NUM ! if the first (top) cumulative probability is not zero, if the last (bottom) cumulative
probability is not one, or if the values or cumulative probabilities are not in ascending order.

Returns #REF! if the number of columns in the table reference is not two.

Returns #VALUE! if the argument is not a reference, if the argument is a defined name but not for
a reference, or if any cell of the table contains text or is blank.

Example

A corporate planner thinks that minimum possible market demand is 1000 units, median is 5000,
and maximum possible is 9000. Also, there is a ten percent chance that demand will be less than
4000 and a ten percent chance it will exceed 7000. The values, x, and cumulative probabilities,
P(X<=x), are entered into spreadsheet cells A2:B6.

Figure 10.27 RandCumulative Example Spreadsheet Data

A B
1 x| P(X<=x)
2 1000 0.0
3 4000 0.1
4 5000 0.5
5 7000 0.9
6 9000 1.0

The function is entered into another cell: =RandCumulative(A2:B6)

Related Function

FastCumulative: Same as RandCumulative without any error checking of the arguments.



10.11 Random Number Generator Functions 131

Figure 10.28 RandCumulative Example Probability Density Function
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RandDiscrete

Returns a random value from a discrete probability distribution. This function can model a
discrete-valued uncertain quantity, X, by specifying its probability mass function. The function is
specified by each possible discrete value, x, and its corresponding probability, P(X=x).

Syntax
RandDiscrete(value discrete table)

Value discrete_table must be a reference, or the defined name of a reference, for a two-column
range, with values in the left column and corresponding probability mass in the right column.

Remarks

Returns #N/A if there are too few or too many arguments.

Returns #NAME! if the argument is text and the name is undefined.

Returns #NUM ! if a probability is negative or if the probabilities do not sum to one.
Returns #REF! if the number of columns in the table reference is not two.

Returns #VALUE! if the argument is not a reference, if the argument is a defined name but not for
a reference, or if any cell of the table contains text or is blank.

Example

A corporate planner thinks that uncertain market revenue, X, can be approximated by three
possible values and their associated probabilities: P(X=10000) = 0.25, P(X=12000) = 0.50, and
P(X=15000) = 0.25. The values and probabilities are entered into spreadsheet cells A2:B4.

Figure 10.30 RandDiscrete Example Spreadsheet Data

A B
1 X P(X=x)
2 $10,000 0.25
3 $12,000 0.50
4 $15,000 0.25

The function is entered into another cell: =RandDiscrete(A2:B4)

Related Function

FastDiscrete: Same as RandDiscrete without any error checking of the arguments.
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Figure 10.31 RandDiscrete Example Probability Mass Function
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Figure 10.32 RandDiscrete Example Cumulative Probability Function
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RandExponential

Returns a random value from an exponential distribution. This function can model the uncertain
time interval between successive arrivals at a queuing system or the uncertain time required to
serve a customer.

Syntax
RandExponential(lambda)

Lambda is the mean number of occurrences per unit of time.

Remarks

Returns #N/A if there are too few or too many arguments.

Returns #NAME! if the argument is text and the name is undefined.
Returns #NUM! if lambda is negative or zero.

Returns #VALUE! if the argument is a defined name of a cell and the cell is blank or contains text.

Examples

Cars arrive at a toll plaza with a mean rate of 3 cars per minute. The uncertain time between
successive arrivals, measured in minutes, is =RandExponential(3). The average value returned by
repeated recalculation of RandExponential(3) is 0.333.
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Figure 10.33 RandExponential Example Probability Density Function
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A bank teller requires an average of two minutes to serve a customer. The uncertain customer
service time, measured in minutes, is =RandExponential(0.5). The average value returned by
repeated recalculation of RandExponential(0.5) is 2.

Related Functions
FastExponential: Same as RandExponential without any error checking of the arguments.

—LN(RAND())/lambda: Excel's inverse of the exponential, or
—LN(RandUniform(0,1))/lambda to use the SimVoi Seed feature.

RandPoisson: Counts number of occurrences for a Poisson process.

135
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RandInteger

Returns a uniformly distributed random integer between two integers you specify.

Syntax
RandlInteger(bottom,top)
Bottom is the smallest integer RandInteger will return.

Top is the largest integer RandInteger will return.

Remarks

Returns #N/A if there are too few or too many arguments.

Returns #NAME! if an argument is text and the name is undefined.
Returns #NUM! if top is less than or equal to bottom.

Returns #VALUE! if bottom or top is not an integer or if an argument is a defined name of a cell
and the cell is blank or contains text.

Example

The number of orders a particular customer will place next year is between 7 and 11, with no
number more likely than the others. The uncertain number of orders is =RandInteger(7,11).
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Figure 10.35 RandInteger Example Probability Mass Function

=x)
o
w
o

Probability, P(X
o
=

0.00 ~+ T t t
5 6 7 8 9 10 11 12 13

Number of Orders Next Year, x

Figure 10.36 RandInteger Example CumulativeProbability Function
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Related Function
FastInteger: Same as RandInteger without any error checking of the arguments.

RandBetween(bottom,top): Excel’s function for uniformly distributed integers, without SimVoi’s
capability of setting the seed.
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RandLogNormal

Returns a random value from a lognormal distribution.

Syntax

RandLogNormal(mean,standard_dev)

RandNormal

Returns a random value from a normal distribution. This function can model a variety of
phenomena where the values follow the familiar bell-shaped curve, and it has wide application in
statistical quality control and statistical sampling.

Syntax
RandNormal(mean,standard_dev)
Mean is the arithmetic mean of the normal distribution.

Standard_dev is the standard deviation of the normal distribution.

Remarks

Returns #N/A if there are too few or too many arguments.

Returns #NAME! if an argument is text and the name is undefined.
Returns #NUM ! if standard _dev is negative.

Returns #VALUE! if an argument is a defined name of a cell and the cell is blank or contains text.

Example

The total market for a product is approximately normally distributed with mean 60,000 units and
standard deviation 5,000 units. The uncertain total market is =RandNormal(60000,5000).
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Figure 10.37 RandNormal Example Probability Density Function
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Figure 10.38 RandNormal Example Cumulative Probability Function
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Related Function
FastNormal: Same as RandNormal without any error checking of the arguments.

NormInv(RAND(),mean,standard_dev): Excel's inverse of the normal, or
NormInv(RandUniform(0,1),mean,standard dev) to use the SimVoi Seed feature.
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RandPoisson

Returns a random value from a Poisson distribution. This function can model the uncertain
number of occurrences during a specified time interval, for example, the number of arrivals at a
service facility during an hour. The possible values of RandPoisson are the non-negative integers,
0,1,2,...

Syntax
RandPoisson(mean)

Mean is the mean number of occurrences per unit of time.

Remarks

Returns #N/A if there are too few or too many arguments.

Returns #NAME! if the argument is text and the name is undefined.
Returns #NUM ! if mean is negative or zero.

Returns #VALUE! if mean is a defined name of a cell and the cell is blank or contains text.

Examples

Cars arrive at a toll plaza with a mean rate of 3 cars per minute. The uncertain number of arrivals
in a minute is =RandPoisson(3). The average value returned by repeated recalculation of
RandPoisson(3) is 3.
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Figure 10.39 RandPoisson Example Probability Mass Function
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Example

A bank teller requires an average of two minutes to serve a customer. The uncertain number of
customers served in a minute is =RandPoisson(0.5). The average value returned by repeated
recalculation of RandPoisson(0.5) is 0.5.

Related Functions
FastPoisson: Same as RandPoisson without any error checking of the arguments.

RandExponential: Describes time between occurrences for a Poisson process.
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RandSample
Returns a random sample without replacement from a population.

To use this random number generator function, select a number of cells equal to the sample size,
either in a single column or in a single row. Type =RandSample( followed by a reference to the
cells containing the population values, enclosed in parentheses. After typing the ending
parentheses, do not press Enter. Instead, hold down the Control and Shift keys while you press
Enter, thus "array entering" the function.

Syntax
RandSample(population)

The population argument is a reference to a range of values in a single column.

Remarks
Returns #N/A if the population range is not part of a single column.

Returns #REF! if the function is not entered into two adjacent cells.

Example

Type population values into cells A2:A6. For a sample of size 3, select cells B2:B4, and type
=RandSample(A2:A6) but don't press Enter. Hold down Control and Shift while you press Enter.
Press F9 to recalculate for a different sample.

A B
1 | Population Data| Sample
2 29 73
3 73 57
4 13 29
5 44
6 57

Related Functions

FastColumnSample: Same as RandSample for two adjacent cells in the same column, without any
error checking of arguments.

FastRowSample: Same as RandSample for two adjacent cells in the same row, without any error
checking of arguments.
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RandTriangular

Returns a random value from a triangular probability density function. This function can model an
uncertain quantity where the most likely value (mode) has the largest probability of occurrence,
the minimum and maximum possible values have essentially zero probability of occurrence, and
the probability density function is linear between the minimum and the mode and between the
mode and the maximum. This function can also model a ramp density function where the
minimum equals the mode or the mode equals the maximum.

Syntax

RandTriangular(minimum,most_likely,maximum)

Minimum is the smallest value RandTriangular will return.
Most _likely is the most likely value RandTriangular will return.

Maximum is the largest value RandTriangular will return.

Remarks
Returns #N/A if there are too few or too many arguments.
Returns #NAME! if an argument is text and the name is undefined.

Returns #NUM! if minimum is greater than or equal to maximum, if most_likely is less than
minimum, or if most likely is greater than maximum.

Returns #VALUE! if an argument is a defined name of a cell and the cell is blank or contains text.

Example

The minimum time required to complete a particular task that is part of a large project is 2 hours,
the most likely time required is 4 hours, and the maximum time required is 10 hours.

The function returning the uncertain time required for the task is entered into a cell:
=RandTriangular(4,6,10).

The probability density chart shows the difference between the RandTriangular function with its
two linear segments and the smoother RandTriBeta function.

Related Function

FastTriangular: Same as RandTriangular without any error checking of arguments.
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Figure 10.41 RandTriangular Example Probability Density Function
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RandTriBeta

Returns a random value from a beta probability density function. This function can model an
uncertain quantity where the most likely value (mode) has the largest probability of occurrence,
and the minimum and maximum possible values have essentially zero probability of occurrence.
The probability density function is a smooth curve between the minimum and the maximum with
its highest point at the mode.

Syntax
RandTriBeta(minimum,most_likely,maximum,shape)
Minimum is the smallest value RandTriBeta will return.
Most _likely is the most likely value RandTriBeta will return.
Maximum is the largest value RandTriBeta will return.

Shape is an optional parameter which determines the peakedness of the density function. If a value
for Shape is omitted, RandTriBeta uses the value Shape = 4.

Remarks
Returns #N/A if there are too few or too many arguments.
Returns #NAME! if an argument is text and the name is undefined.

Returns #NUM! if minimum is greater than or equal to maximum, if most_likely is less than
minimum, or if most likely is greater than maximum.

Returns #VALUE! if an argument is a defined name of a cell and the cell is blank or contains text.

Related Function

FastTriBeta: Same as RandTriBeta without any error checking of arguments.

Example

The minimum time required to complete a particular task that is part of a large project is 2 hours,
the most likely time required is 4 hours, and the maximum time required is 10 hours.

The function returning the uncertain time required for the task is entered into a cell: =
RandTriBeta (2,4,10).

The charts show the shapes of RandTriBeta(2,4,10) where the solid line uses the default shape
value 4. The flatter dotted line shows RandTriBeta(2,4,10,2), and the peaked dashed line shows
RandTriBeta(2,4,10,6).
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Figure 10.43 RandTriBeta Example Probability Density Function
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RandTruncBiVarNormal

Returns a pair of random values from a bivariate normal probability density function with
specified correlation, where each marginal distribution is truncated.

Syntax

RandTruncBiVarNormal(meanl,stdevl,mean2,stdev2,correl12,[minl],[max1],[min2],[max2])
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RandTruncLogNormal

Returns a random value from a truncated log normal probability density function. This function
can model an uncertain quantity with a positively-skewed density function where extreme values
in the tails of the distribution are not desired. Subranges of the truncated UQ have the same
relative probabilities as the same subranges of the original log normal distribution.

Syntax

RandTruncLogNormal(Mean,StDev,MinValue,MaxValue)

Mean and StDev are the parameters for the original log normal distribution.
MinValue is the smallest value RandTruncLogNormal will return.
MaxValue is the largest value RandTruncLogNormal will return.

MinValue and MaxValue are optional arguments.

Remarks: Same as RandTruncNormal

RandTruncNormal

Returns a random value from a truncated normal probability density function. This function can
model an uncertain quantity with a bell-shaped density function where extreme values in the tails
of the distribution are not desired. Subranges of the truncated UQ have the same relative
probabilities as the same subranges of the original normal distribution.

Syntax

RandTruncNormal(Mean,StDev,MinValue,MaxValue)

Mean and StDev are the parameters for the original normal distribution.
MinValue is the smallest value RandTruncNormal will return.
MaxValue is the largest value RandTruncNormal will return.

MinValue and MaxValue are optional arguments.

Remarks
Returns #N/A if a value between MinValue and MaxValue is not found after 10,000 attempts.
Returns #NUM ! if MinValue is greater than or equal to MaxValue.

Returns #VALUE! if an argument cannot be interpreted as a numeric value.
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Related Function

FastTruncNormal: Same as RandTruncNormal, but with error checking only for maximum of
10,000 attempts.

Example

An uncertain quantity has a normal distribution with mean = 100 and standard deviation = 10, but
values are restricted between 90 and 120.

The function returning the uncertain quantity is entered into a cell: = RandTruncNormal
(100,10,90,120).

Figure 10.45 shows the original normal density function with mean = 100 and standard deviation
= 10. The density function is rescaled so that the total area under the curve between 90 and 120 is
equal to one. The corresponding cumulative distributions are shown in Figure 10.46.

For example, with the original normal density function, P(100<=X<=110) = 0.341, and
P(110<=X<=120) = 0.136. The ratio of P(100<=X<=110) to P(110<=X<=120) is 0.341/0.136 =
2.512. Thus, a value in the range 100 to 110 is approximately 2.5 times as likely as a value in the
range 110 to 120.

With the truncated normal density function, P(100<=X<=110) = 0.417, and P(110<=X<=120) =
0.166. The ratio of P(100<=X<=110) to P(110<=X<=120) is 0. 417/0.166 = 2.512. Thus, a value
in the range 100 to 110 is still approximately 2.5 times as likely as a value in the range 110 to 120.
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Figure 10.45 RandTruncNormal Probability Density Function
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Figure 10.46 RandTruncNormal Cumulative Probability Function
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RandUniform

Returns a uniformly distributed random value between two values you specify. As a special case,
RandUniform(0,1) is the same as Excel's built-in RAND() function.

Syntax
RandUniform(minimum,maximum)
Minimum is the smallest value RandUniform will return.

Maximum is the largest value RandUniform will return.

Remarks

Returns #N/A if there are too few or too many arguments.
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Returns #NAME! if an argument is text and the name is undefined.
Returns #NUM! if minimum is greater than or equal to maximum.

Returns #VALUE! if an argument is a defined name of a cell and the cell is blank or contains text.

Example

A corporate planner thinks that the company's product will garner between 10% and 15% of the
total market, with all possible percentages equally likely in the specified range. The uncertain
market proportion is =RandUniform(0.10,0.15).

Figure 10.47 RandUniform Example Probability Density Function
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Figure 10.48 RandUniform Example Cumulative Probability Function
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FASTUNIFORM: Same as RandUniform without any error checking of the arguments.
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10.12 SIMVOI TECHNICAL DETAILS

SimVoi's random number generator functions are based on a uniformly distributed random
number function called RandSeed which is not directly accessible by the user. RandSeed returns a
random value x in the range 0<x<=1. Internally, decimal values for RandSeed are calculated by
dividing a uniformly distributed random integer by 2,147,483,647, which is RandSeed's period.
Random integers in the range 1 through 2,147,483,647 are generated using the well-documented
Park-Miller algorithm, where each random integer depends on the previous random integer.

When SimVoi starts, the initial integer seed depends on the system clock. Unlike Excel's RAND()
function, you can use SimVoi at any time to specify an integer seed in the range 1 through
2,147,483,647, which is used as the previous random integer for the sequence of random numbers
generated by the SimVoi functions.

In the SimVoi dialog box, the Random Number Seed edit box changes the seed only for the
SimVoi functions; it does not have any effect on Excel's built-in RAND() function.

Each of SimVoi's random number generator functions use RandSeed as a building block.

RandBeta(alpha,beta,,[MinValue],[MaxValue]) uses RandSeed as the cumulative probability in
Excel's built-in BETAINV function.

RandBinomial(trials,probability s) uses RandSeed as the cumulative probability in Excel's built-in
CRITBINOM function.

RandBiVarNormal(meanl,stdev1,mean2,stdev2,correl12) uses two values of RandNormal to
obtain correlated normal values.

RandCumulative(value cumulative table) uses the value of RandSeed, R, searches to find the
adjacent cumulative probabilities that bracket R, and interpolates on the linear segment of the
cumulative distribution to find the corresponding value.

RandDiscrete(value discrete table) compares RandSeed with summed probabilities of the input
table until the sum exceeds the RandSeed value, and then returns the previous value from the input
table.

RandExponential(lambda) uses the value of RandSeed, R, as follows. If the exponential density
function is f(t) = lambda*EXP(-lambda*t), the cumulative is P(T<=t) = 1 - EXP(-lambda*t).
Associating R with P(T<=t), the inverse cumulative is t = -LN(1-R)/lambda. Since R and 1-R are
both uniformly distributed between 0 and 1, SimVoi uses -LN(R)/lambda for the returned value.

RandlInteger(bottom,top) returns bottom + INT(RandSeed*(top-bottom+1)).

RandLogNormal(Mean,StDev) transforms Mean and StDev, uses RandSeed and the transformed
values in SimVoi’s RandNormal function, and transforms the normal result to obtain the log
normal value.

RandNormal(mean,standard_dev) uses two RandSeed values in the well-documented Box-Muller
method.

RandPoisson(mean) compares RandSeed with cumulative probabilities of Excel's built-in
POISSON function until the probability exceeds the RandSeed value, and then returns the
previous value.
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RandSample(population) uses RandSeed for each of the cells that were selected when the function
was array-entered, avoiding population values that have already been selected, thus providing
sampling without replacement.

RandTriangular(minimum,most_likely,maximum) uses RandSeed once. The triangular density
function has two linear segments, so the cumulative distribution has two quadratic segments. The
returned value is determined by interpolation on the appropriate quadratic segment.

RandTriBeta(minimum,most likely,maximum,[shape]) uses several formulas to transform min-
mode-max into the beta function alpha and beta parameters and then uses RandSeed as the
cumulative probability in Excel's built-in BETAINV function.

RandTruncBiVarNormal(meanl,stdevl,mean2,stdev2,correl12,[minl],[max1],[min2], [max2])
uses values of RandBiVarNormal until normal values are found between the pairs of min and max
values or until it has made 10,000 attempts.

RandTruncLogNormal(Mean,StDev,MinValue,MaxValue)) uses values of RandNormal until a log
normal value is found between MinValue and MaxValue or until it has made 10,000 attempts.

RandTruncNormal(Mean,StDev,MinValue,MaxValue)) uses values of RandNormal until a value
is found between MinValue and MaxValue or until it has made 10,000 attempts.

RandUniform(minimum,maximum) returns minimum + RandSeed*(maximum-minimum).
RandUniform(0,1) is equivalent to Excel's built-in RAND() function.

SimVoi includes a Fast... version of each of the seventeen functions, e.g., FastBinomial,
FastCumulative, etc. The Fast... functions are identical to the Rand... functions except there is no
error checking of arguments.



